
Intro to Linear Regression

Overview

• Review of Underlying Concepts in Inferential Statistics
• Understanding Linear Models
• Terms in Linear Models
• An Example
• Further Considerations

Review of Underlying Concepts

Review of Underlying Concepts

• Variance & Covariance
– Importance in statistical analyses

• Covariance & Correlation
– Relationship between them
– Why use one or the other?
– Both are descriptive statistics

∗ Even though tests can be run on them

Review of Underlying Concepts (cont.)

• Assumptions made in computing correlations
– Measurement level is correctly conceived (ordinal, interval, ratio, etc.)
– Relationship is linear

• Assumptions made in testing their significance
– Monotonicity

∗ For Pearson’s r, also that variables are normally distributed & homoscedastic
· And that the variables are bivariate normal

– No big outliers

Review of Underlying Concepts (cont.)

• Partial & Semipartial Correlations
– Semipartial correlations remove the effect of another variable from one of the correlated pair
– Could remove the effect of several other variables from one of the pair

∗ (Or create even more complex arrangements, like canonical correlations)

Review of Underlying Concepts (cont.)

• Correlations & Error
– Correlations separate dispersion into variance & covariance

∗ But make no assumptions about where error comes from
– However, when testing significance of Pearson’s r, error is assumed to be normally distributed
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Review of Underlying Concepts (end)

• Correlations & Error (cont.)

– The (unshared) variances of both variables comprise the denominator
∗ (This will be different for linear regression models)

Understanding Linear Models

Basic Concepts

• Simplest form of a linear relationship is 𝑌 = 𝑏𝑋
– Where:

∗ 𝑌 = Outcome / response / criterion / DV
∗ 𝑋 = Predictor / input / IV
∗ 𝑏 = Slope of 𝑋

· The typical null hypothesis (H0) of “no effect” is expressed here as:
𝑏1 = 0

· (If data are standardized, the convention is to write � instead of 𝑏)

Basic Concepts (cont.)

• However, we typically add: 𝑌 = 𝑏0 + 𝑏1𝑋1 + 𝑒
– 𝑌 = Outcome
– 𝑏0 = Value of 𝑋 at y-axis intercept
– 𝑏1 = Slope of 𝑋
– 𝑋1 = Predictor 𝑋1
– 𝑒 = Error

Linear Models vs. Correlations

• For a correlation:

𝑟 = Cov(𝑋1, 𝑌 )
SD(𝑋1)SD(𝑌 )

• The (unshared) variances of both variables comprise the denominator
• This is equivalent to simply drawing a line of “best fit” through the data

– Without worrying about orientation
∗ I.e., without worrying about where the axes are—or where unshared variance is coming from
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Linear Models vs. Correlations (cont.)

𝑟 = Cov(𝑋1,𝑌 )
SD(𝑋1)SD(𝑌 ) ; here, 𝑟 = .86:

Linear Models vs. Correlations (cont.)

• For a linear regression, we instead minimize variance for only one variable

– Typically the outcome
– This assumes that all variance (error) resides in the outcome

• So, in 𝑌 = 𝑏0 + 𝑏1𝑋 + 𝑒:

𝑏1 = Cov(𝑋1, 𝑌 )
(SD(𝑌 ))2
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Linear Models vs. Correlations (cont.)
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More About the Equation

• 𝑌 = 𝑏0 + 𝑏1𝑋1 + 𝑒
• Note again that error is separated out

– And placed on the side with the predictor

• Implications:

– The value of 𝑋1 per se is without error
∗ Because error is separated out (as 𝑒)

– The intercept, slope, & error can be estimated separately
∗ And their covariances with 𝑌 are thus separated

More About the Equation (cont.)

• Adding more specificity to the equation:
̂𝑌𝑖 = 𝑏0 + 𝑏1𝑋𝑖1 + 𝑒𝑖

– ̂𝑌𝑖 = Predicted value of 𝑌 for participant 𝑖
– 𝑏1 = Slope for variable 𝑋1
– 𝑋𝑖1 = Value on 𝑋1 for participant 𝑖
– 𝑒𝑖 = Error of measurement of participant 𝑖’s outcome
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More About the Equation (cont.)

• Participant 𝑖’s score on 𝑋1 here is 2.10
• The predicted value of 𝑌𝑖 for participant 𝑖 is:

– ̂𝑌𝑖 = −0.18 + (1.93 × 2.10) = 3.97
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• The actual value of 𝑌𝑖 for participant 𝑖 also includes the error:

– 𝑌𝑖 = −0.18 + (1.93 × 2.10) + 4.13 = 8.00
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More About the Equation (end)

• Adding another variable to the equation:
̂𝑌𝑖 = 𝑏0 + 𝑏1𝑋𝑖1 + 𝑏2𝑋𝑖2 + 𝑒𝑖

– 𝑋𝑖2 = Participant 𝑖’s value on the other variable (𝑋2) added to the model
– 𝑏2 = Slope for 𝑋2

• Since there are multiple predictors (𝑋s) in this model,
– This is called a multiple linear model
– Or multiple linear regression

Linear Models vs. ANOVAs

• ANOVA (and ANCOVA, MANOVA, etc.)
– Is a type of linear regression
– Results focus on significance of variables

∗ When all are present in the model together
• Linear Regression

– Is a more flexible framework
– Can model complex relationships & data structures

∗ E.g., non-linear relationships & nested data
– And can test whole models

∗ And changes to the whole model when variables are added or removed
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Questions Best Addressed by ANOVAs vs. Linear Models

• ANOVAs (and ANCOVAs, MANOVAs, etc.) can ask:

– Which variable is significant?
– Is there an interaction between variables?

• Linear regressions can also ask:

– What is the best combination of variables?
– Does a given variable—or set of variables—significantly contribute to what we already know?

Terms in Linear Models

Adding More Terms to Models

• We can continue to add more variables to the model, e.g., 𝑋3 and 𝑋3:

̂𝑌𝑖 = 𝑏0 + 𝑏1𝑋𝑖1 + 𝑏2𝑋𝑖2 + 𝑏3𝑋𝑖3 + 𝑏4𝑋𝑖4 + 𝑒𝑖

• When there are a lot of variables in the model, then we usually abbreviate the equation:

̂𝑌𝑖 = 𝑏0 + 𝑏1𝑋𝑖1... + 𝑏𝑘𝑋𝑖𝑘 + 𝑒𝑖

– Were 𝑘 is the number of variables

Adding More Terms to Models (cont.)

̂𝑌𝑖 = 𝑏0 + 𝑏1𝑋𝑖1... + 𝑏𝑘𝑋𝑖𝑘 + 𝑒𝑖

• We can test interactions by adding additional terms

– E.g., ...𝑏1𝑋𝑖1 + 𝑏2𝑋𝑖2 + b3(Xi1Xi2)...
• Or test non-linear effects, also by adding terms

– E.g., ...𝑏1𝑋𝑖1 + b2X2
i1...

Adding More Terms to Models (end)

• Just as we separated out the effects of the predictors,

– We can separate out sources of error
∗ E.g., per predictor/term in the model

• We can also combine error terms

– E.g., when we “nest” one variable into another
∗ We will cover this when we discuss multilevel (aka hierarchical) models
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Signal-to-Noise in Linear Models

• Signal-to-noise in the equation

̂𝑌𝑖 = 𝑏0 + 𝑏1𝑋𝑖1... + 𝑏𝑘𝑋𝑖𝑘 + 𝑒𝑖

• The variance in ̂𝑌𝑖 is divided into:

– Changes due to the predictors
– Changes due to “other things” (and relegated to error / noise term(s)
– I.e., into signals and noise(s)
– (N.b., the intercept, 𝑏0, is a constant and not included in this partitioning of variance)

Signal-to-Noise in Linear Models (cont.)

̂𝑌𝑖 = 𝑏0 + 𝑏1𝑋𝑖1... + 𝑏𝑘𝑋𝑖𝑘 + 𝑒𝑖

• The sum of squares representation of this partition into predictors & error looks like:

𝑛
∑
𝑖=1

(𝑌𝑖 − 𝑌 )2 = ∑
𝑖

( ̂𝑌𝑖 − 𝑌 )2 + ∑
𝑖

(𝑌𝑖 − ̂𝑌𝑖)2

Signal-to-Noise in Linear Models (cont.)
𝑛

∑
𝑖=1

(𝑌𝑖 − 𝑌 )2 = ∑
𝑖

( ̂𝑌𝑖 − 𝑌 )2 + ∑
𝑖

(𝑌𝑖 − ̂𝑌𝑖)2

• I.e.,the squared sum of the differences of each instance (𝑌𝑖) from the mean (𝑌 ) equals:

– The squared sum differences of each predicted value ( ̂𝑌𝑖) from the mean
– Plus the squared sums of differences of the actual values (𝑌𝑖s) from the respective predicted values

Signal-to-Noise in Linear Models (cont.)

• Another way of saying this:

𝑛
∑
𝑖=1

(𝑌𝑖 − 𝑌 )2 = ∑
𝑖

( ̂𝑌𝑖 − 𝑌 )2 + ∑
𝑖

(𝑌𝑖 − ̂𝑌𝑖)2

• Is to say this:
Total SS = SS from Regression + SS from Error

– Or, further condensed as:
∗ 𝑆𝑆𝑇 𝑜𝑡𝑎𝑙 = 𝑆𝑆𝑅𝑒𝑔. + 𝑆𝑆𝐸𝑟𝑟𝑜𝑟
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Signal-to-Noise in Linear Models (cont.)

• Using 𝑆𝑆𝑇 𝑜𝑡𝑎𝑙 = 𝑆𝑆𝑅𝑒𝑔. + 𝑆𝑆𝐸𝑟𝑟𝑜𝑟,
– We can compute the ratio of predicted to actual:

Ratio of Predicted-to-Actual Variance = 𝑆𝑆𝑅𝑒𝑔.
𝑆𝑆𝑇𝑜𝑡𝑎𝑙

∗ Or, equivalently as 1 − 𝑆𝑆𝑅𝑒𝑔.
𝑆𝑆𝐸𝑟𝑟𝑜𝑟

. . .

• We typically represent this ratio as R²:

𝑅2 = 𝑆𝑆𝑅𝑒𝑔.
𝑆𝑆𝑇 𝑜𝑡𝑎𝑙

= 1 − 𝑆𝑆𝑅𝑒𝑔.
𝑆𝑆𝐸𝑟𝑟𝑜𝑟

. . .
Yep, that’s what 𝑅2 means in ANOVAs �

The Equation’s Terms

̂𝑌𝑖 = 𝑏0 + 𝑏1𝑋𝑖1... + 𝑏𝑘𝑋𝑖𝑘 + 𝑒𝑖

• 𝑌 is assumed to follow a certain distribution
– This determines how error is modeled
– E.g., is error usually assumed to be normally distributed
– But both distributions can be assumed to be something else

∗ E.g., logarithmic

The Equation’s Terms (cont.)

̂𝑌𝑖 = 𝑏0 + 𝑏1𝑋𝑖1... + 𝑏𝑘𝑋𝑖𝑘 + 𝑒𝑖:

• 𝑋s can be nominal, ordinal, interval, or ratio
– This affects how those variables are modeled
– As well as the error related to them

• We could transform the terms on the right
– E.g., raise them to a power or take their log

The Equation’s Terms (cont.)

̂𝑌𝑖 = 𝑏0 + 𝑏1𝑋𝑖1... + 𝑏𝑘𝑋𝑖𝑘 + 𝑒𝑖:

• For an ANOVA:
– 𝑌 is assumed to be normally distributed
– The 𝑋s are nominal
– And the terms are not transformed

∗ Called an “identity” because they are multiplied by 1
– This “identity transformation” looks like this:

̂𝑌𝑖 = 1 × (𝑏0 + 𝑏1𝑋𝑖1...𝑏𝑘𝑋𝑖𝑘 + 𝑒𝑖)
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The Equation’s Terms (end)

• The terms can be transformed in other models
– This transformation is called a Link Function

∗ Since it “links” the terms on the right to the predicted value of 𝑌 on the left
• E.g., logistic regression uses a logarithmic (𝑒) link:

̂𝑌𝑖 = 𝑒𝑏0+𝑏1𝑋𝑖1+⋯+𝑏𝑘𝑋𝑖𝑘
1+𝑒𝑏0+𝑏1𝑋𝑖1+⋯+𝑏𝑘𝑋𝑖𝑘

which is more often written as:
ln ̂𝑌𝑖

1− ̂𝑌𝑖
= 𝑏0 + 𝑏1𝑋𝑖1 + ⋯ + 𝑏𝑘𝑋𝑖𝑘

Generalized Linear Models

• That very general family of models is referred to as generalized linear models
– ANOVAs, t-tests, and all other linear regressions are types of generalized linear models
– Generalized linear models typically use maximum likelihood estimation (MLE) to compute terms

∗ The ordinary least squares of ANOVAs, etc. is itself a specific type of MLE
· (If assumptions are met)

Generalized Linear Models (cont.)

• N.b., confusingly, in addition to generalized linear models,
– There are general linear models
– “General linear model” simply refers to models you already know.

∗ I.e., those with:
· Normally-distributed, iid variables
· Identity link functions

∗ Like ANOVAs & multiple linear regressions

Generalized Linear Models (end)

• Assumptions of generalized linear models:
– Relationship between response and predictors must be expressible as a linear function

∗ But many can model heteroscedasticity well
– Cases must be independent of each other

∗ But predictors should not be too inter-correlated (lack of multicollinearity)
– The random & link functions should approximate the real functions

An Example

Predicting BMI from Sex & Neighborhood Safety

• Predicting body mass index levels among adolescents from:
1. Whether an adolescent is biologically female
2. Whether they feel their neighborhood is safe

• via SPSS (v. 29)
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Data Used

• From the National Longitudinal Study of Adolescent to Adult Health (Add Health)

– Using the prepared add_health.sav dataset
– Since data are longitudinal, only the first instance (wave) of data collection was used

∗ Selected via:
1. Data > Select Cases...
2. Under If condition is satisfied, added Wave = 1 to select only the first wave

Descriptives

• The mean BMI (29.144) was nearly obese
• Since Bio_Sex was coded 0 = Male & 1 = Female, 52% of the participants were biologically female
• And 90% reported feeling safe in their neighborhood
• About 77% (5025/6503) of cases had data on all three variables

Descriptives (cont.)

• BMI was positively skewed
• So, those with exceptionally high BMIs affect the results more
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Descriptives: Q-Q Plot

• Analyze > Explore... > Plots > Normality plots with tests
• That skew—and a limited lower range—caused some deviations from normality
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Descriptives: 2 × 2 Table

• Analyze > Descriptives Statistics > Crosstabs...
• The number of adolescents who felt safe in their neighborhood is not significantly different between

the sexes

Correlations

• The correlations also reflect the weak relationship between Bio_Sex & Feel_Safe_in_Nghbrhd
• Feeling safe—but not sex—significantly correlated with BMI
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Correlations with CIs

• The 95% confidence intervals (and correlations themselves) are slightly different when using Fisher’s
r-to-z transformation versus bootstrapping

• Given the deviations from normality, bootstrapping is preferable here

95% confidence intervals generated from Fisher’s r-to-z transformation:

95% confidence intervals generated from bootstrapping:

Linear Regression

• Conducted via:

1. Analyze > Regression > Linear
2. BMI as Dependent
3. Bio_Sex & Feel_Safe_in_Nghbrhd as predictors in Block 1 of 1

Linear Regression (cont.)

• The combination of Bio_Sex & Feel_Safe_in_Nghbrhd did not explain much of the variance in BMI
scores

– The R² was .004; adjusted for number of terms in the model, it was .003
– This combination of variables thus only accounted for about 0.3% – 0.4% of the total variance in

BMIs
∗ The high standard error, however, indicates that replications may find rather different R²s
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Linear Regression (cont.)

• Nonetheless, the model was significant

– The intercept & sample size both surely helped

• This ANOVA source table presents the effect of the overall model

– Like first testing a variable in an ANOVA before conducting post hocs, this helps protect against
over-interpreting

Linear Regression (cont.)

• Both biological sex & feeling safe in one’s neighborhood both significantly predicted BMI
• The standardized � for sex means its effect size was close to “small”

– It is “medium” for feeling safe (q.v. �² criteria in this table)

• The positive effect for sex means those identifying as female (1s) tended to have higher BMIs than
those identifying as male (0s)

• The negative value for feeling safe means those who felt safe (1s) tended to have lower BMIs than those
who didn’t (0s)
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Interpretting the Effects

• Writing these results in linear equation form:

̂BMI = 30.205 + (0.325 × Sex) + (−1.383 × Feeling Safe)

Interpretting the Effects (cont.)

̂BMI = 30.205 + (0.325 × Sex) + (−1.383 × Feeling Safe)

• Since Bio_Sex was coded 0 = Male & 1 = Female

– And Feel_Safe_in_Nghbrhd as 0 = No & 1 = Yes,

• We predict that the BMI

– For a male (0)
– Who does not feel safe (0)
– Is 30.205:

̂BMI = 30.205 + (0.325 × 0) + (−1.383 × 0)
= 30.205 + 0 + 0
= 30.205

Interpretting the Effects (cont.)

̂BMI = 30.205 + (0.325 × Sex) + (−1.383 × Feeling Safe)

• The predicted BMI for

– A female (1)
– Who does not feel safe (0)
– Is 30.530:

̂BMI = 30.205 + (0.325 × 1) + (−1.383 × 0)
= 30.205 + 0.325 + 0
= 30.530
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Interpretting the Effects (cont.)

̂BMI = 30.205 + (0.325 × Sex) + (−1.383 × Feeling Safe)

• The predicted BMI for

– A male (0)
– Who does feel safe (1)
– Is 29.147:

̂BMI = 30.205 + (0.325 × 0) + (−1.383 × 1)
= 30.205 + 0 − 1.383
= 29.147

• Etc.

Further Considerations

Multicollinearity

• When two or more predictors share too much variance

– I.e., are strongly correlated

• Two general sources:

1. Structural: Caused by how the model was constructed

– E.g., adding interaction terms

1. Data: Caused by variables that are inherently correlated

Multicollinearity (cont.)

• Problems caused by multicollinearity:

– Parameter estimates of multicollinear terms can be unstable
∗ And even reverse sign

– Reduces the power of the whole model
∗ Because the parameter estimates are less precise

Multicollinearity (cont.)

• Multicollinearity doesn’t typically affect the whole model’s R²

– Or the model’s good-of-fit statistics

• It mostly impairs interpretation of individual predictors
• Can be tested with variance inflation factor (VIF)

– VIF ranges from 1 to ∞
– Where values >10 indicate problems
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Multicollinearity (cont.)

• Addressing multicollinearity
– Centering variables (subtracting the mean) can reduce structural multicollinearity (Iacobucci et

al., 2016)
– Remove one of the correlated variables
– Only test/compare overall model fit
– Use another analysis

∗ E.g., canonical correlations or principal component analysis

Multicollinearity (end)

• Multicollinearity is typically not a concern if the variables with high multicollinearity are:
– Control variables
– Intentional products of other variables

∗ E.g., interaction terms, raised to a power, etc.
– Dummy variables

Independence of Cases

• When one case (participant, round of tests, etc.) is correlated with another case
• Can also produce unstable parameter estimates

– Thus affecting significance tests
∗ Through both false positives (Type 1) & false negatives (Type 2)

• May also affect model goodness of fit
– And not isolated to a few predictors

Independence of Cases (cont.)

• Addressing non-independence
– Best is through research design
– Can also model inter-dependence

∗ E.g., nesting cases
· As is done explicitly in multilevel (hierarchical) models

The Games

• Space Invaders
• Lunar Lander
• Asteroids

– Doesn’t work well on Firefox
• Tempest
• Star Wars
• Battlezone
• Elite
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